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Chapter 1 Software Description

Software that Enables the Field Configuration of Banner I0-Link Masters and Banner |O-Link Devices

» Allows the configuration of Banner |0-Link devices

» Free to download and available on the product pages for
the DXMR110-8K, DXMR90-4K, R90C-4K-MQ, and R45C-2K-MQ 10-
Link masters

+ Works on Microsoft® Windows® 7 and 10"

* BWA-UCT-900 or Ethernet cable required to connect PC-based 10-
Link Configuration Software to Banner IO-Link masters and Banner
IO-Link devices, depending on which Banner 10-Link master you are
using

NOTE: Administrative rights are required to install the 10-
Link Configuration Software.

Overview

Banner's 10-Link Configuration Software offers an easy way to configure Banner 10-Link masters and Banner 10-Link
devices, offering users full control of master and device configuration. The easy-to-use software provides a variety of tools
and works with the DXMR110-8K, DXMR90-4K, R90C-4K-MQ, and R45C-2K-MQ |O-Link masters.

Configure Banner 10-Link masters and Banner IO-Link devices using the free 10-Link Configuration Software, available for
download at https://www.bannerengineering.com/us/en/products/software/io-link-software.html.

() Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries.
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Chapter 2 Specifications and Requirements

|O-Link Configuration Software PC Requirements

Operating System USB
Microsoft® Windows® operating system versions 7 or 10(") Available USB port
Hard Drive Space Screen Resolution
120 MB 1366 x 768 full-color minimum

Wap ) ) ) Third-Party Software
(™ Microsoft® and Windows® are registered trademarks of Microsoft®
Corporation in the United States and/or other countries. .NET version 4.6.2 or higher

IMPORTANT: Administrative rights are required to install the 10-Link Configuration Software.

Adapter Cable — Required for use with Serial |O-Link Masters

An adapter cable, model BWA-UCT-900, is required for use with the 10-Link Configuration Software, Banner R90C-4K-MQ,
and Banner R45C-2K-MQ serial IO-Link masters. Use the adapter cable to connect Banner serial 10-Link devices to read,
write, and preview device configurations.

. » Connects Banner serial 10-Link masters to the PC-based |0-Link
¢ Configuration Software
. \ )

Model
Model Adapter Length Connections
BWA-UCT-900 RS-485 to USB 1 m (3.28 ft) USB and 5-pin M12 quick-disconnect connector

BWA-UCT-900 Adapter Cable Specifications

Input Voltage Output Voltage
5V DC from USB Type A connector 24 V DC power output for a single device transmitting at 1
I Watt
Certifications
Operating Conditions

C € —40 °C to +80 °C (—40 °F to +176 °F)

95% maximum relative humidity (non-condensing)
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Ethernet Cordset — Required for use with Ethernet |O-Link
Masters

An Ethernet cordset is required for use with the IO-Link Configuration Software, Banner DXMR110-8K, and Banner
DXMR90-4K IO-Link masters with an Ethernet IP interface. Use an M12 to RJ45 Ethernet cordset to connect to Banner
Ethernet |O-Link masters to read, write, and preview device configurations.

RJ45

* Connects Banner Ethernet |O-Link masters to the PC-based |10-

r‘* 474 Typ. Link Configuration Software

M12x1.0
2 14.5—
Models
Model Adapter Lengths Connections
STP-M12D-4xx M12 D-code fo RJ45 123 2 E?Ef?t) Ethernet and 4-pin M12 quick-disconnect connector

Shielded Ethernet 9.14 m (30 ft)

FCC Part 15 Class B for Unintentional Radiators

(Part 15.105(b)) This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

» Consult the dealer or an experienced radio/TV technician for help.

(Part 15.21) Any changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate this
equipment.

Industry Canada ICES-003(B)

This device complies with CAN ICES-3 (B)/NMB-3(B). Operation is subject to the following two conditions: 1) This device may not cause harmful interference;
and 2) This device must accept any interference received, including interference that may cause undesired operation.

Cet appareil est conforme a la norme NMB-3(B). Le fonctionnement est soumis aux deux conditions suivantes : (1) ce dispositif ne peut pas occasionner
d'interférences, et (2) il doit tolérer toute interférence, y compris celles susceptibles de provoquer un fonctionnement non souhaité du dispositif.
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Chapter 3 Installation Instructions

Install the Software

IMPORTANT: Administrative rights are required to install the IO-Link Configuration Software.

1. Download the latest version of the software from https://www.bannerengineering.com/us/en/products/software/io-link-
software.html.

. Navigate to the downloaded file IOLConfigInstaller.exe.

. Double-click the installer to open Banner IO-Link Configuration Software Setup.
. Accept the terms in the License Agreement by selecting the checkbox.

. Click Install to install the software.

. Depending on the system settings, a pop-up window may appear prompting to allow the 10-Link Configuration
Software to make changes to the computer. Click Yes.

7. Click Close to exit the installer after installation is complete.

o b~ ON

Connect the Cables

For serial |O-Link masters:
1. With the BWA-UCT-900 adapter cable, plug the M12 connector into male connector of the 10-Link master.
2. Plug the USB connector of the BWA-UCT-900 into the PC.
3. Plug the power cable of the BWA-UCT-900 into a wall outlet.

For Ethernet 10-Link masters:
1. With an Ethernet cordset, plug the M12 connector into the male connector of the IO-Link Master.
2. Plug the RJ45 connector of the Ethernet cordset into the PC.

Connect an I0O-Link Device with a Cable

To connect Banner IO-Link devices:
1. Connect the Banner IO-Link device or devices to the ports on the 10-Link masters using an M12 cordset.
2. Plug the applicable accessory into the I0-Link master:
a. For serial 10-Link masters: Use the BWA-UCT-900 adapter cable, and plug the female M12 connector into the
male M12 communication port on the serial I10-Link master.

b. For Ethernet IO-Link masters: Use an Ethernet cordset, and plug the male M12 connector into the female M12
D-code Ethernet port on the Ethernet |O-Link master.

3. Plug the USB or RJ45 connector into the PC.

June 11, 2024 © Banner Engineering Corp. All rights reserved. page 6
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Example - Serial IO-Link Master Device Connection

@ IO-Link

Banner
Device

m

19AV]

BWA-UCT-900 Adapter Cable

Serial 10-Link Master (Ex. R45C-2K-MQ)
PC Running 10-Link Configuration Software
M12 Cordset (Ex. MQDEC-401SS)

Banner 10-Link Device

mooOw>

4
Load an IO-Link Device IODD

After connecting a Banner IO-Link master to a PC, use one of these methods to connect 10-Link devices to the 10-Link
Configuration Software.

Use the IODD Finder

Use the software to scan the connected device to download and install the IODD files automatically.
Use this method if there is not an 10DD file already downloaded onto the PC. See "Add the I0DD File Manually" on page 8.

1. Click Connect on the |0-Link Configuration Software start page.

Connect the |O-Link master
File Home Log  Help

¥ Load 100D @ Exit

10-Link Configuration Software
<

@ IO-Link®

BANNER ]

orusevith RASC.R30C and DANRSD 10-Lnk Msr

@ Not Connected

An 10DD Not Loaded pop-up window appears when the 10-Link device is connected successfully.
2. Select Search for IODD(s) on IODD Finder.

June 11, 2024 © Banner Engineering Corp. All rights reserved. page 7
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IMPORTANT: An internet connection on the PC is required for this functionality.

10DD Finder
Fle Home Device lLog  Help =
> Coad 100D @ Bt
DXMR110-8K | RASCKIMIQ(E)  S15C-MGN-KQ(D)
Vendor Info
Vendor Banner Engineering Corporation
10-Link § @ 10DD Not Loaded - o X

Product Info

10DD(s) not loaded for connected device(s):
Product §15C

MGN-KQ

Descript

Revision

Master

s Search for I0DD(s) on I0DD Finder

Cancel

“Internet connection required for search ta work

10-Link Master: DXMR110-8K Connected

A Load Successful pop-up window appears when the I0ODD file is installed successfully. Click OK to close.

Load Successful
Fle Home Device lLog  Help =
‘_Load\OOD O Bt
DXMR110-8K RA5C-KII-IQ (3) $15C-MGNI-KQ (T)

General

s VendorInfo
ort Setup
Vendor Banner Engineering Corporation
10-Link Vendor ID__|451
T | Load Successful X

10-Link Master: DXMR110-8K Connected

Add the IODD File Manually

1. Download the Banner IO-Link device IODDs manually.
a. Go to www.bannerengineering.com.

You can also go to ttps://ioddfinder.io-link.com/ to search and download device |IODDs.
b. Search for the desired Banner IO-Link devices.
c. Click Product Detail.

Search for the Product (LM150KIQP shown)

BANNER'S CALL FOR PARTS CREATES A STEADY WORKFLOW AND PINPOINTS CRITICAL ISSUES. LEARM MORE,

<>

GEN  HowToBuy

@ oy ccous

+ e w0 (ESREUE
APPLICATIONS SUPPORT COMPANY

@ add 1o My Library

INDUSTRIES PRODUCTS

Search Results For "LM150KIQP"

) L

MNARROW RESULTS EXACT SEARCH MATCH

LM1S0KIQP (803940)
. ement Sensor, Range: 50150 mm

LIST PRICE CURRENT $TOCK:
TveE

PRODUCT

Installation Instructions

d. On the product page, under Downloads, navigate to the IODD file and click the download button.

page 8 © Banner Engineering Corp. All rights reserved.
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Wi i
Download the I0DD Files
PRODUCT DATA FILES oate Tvee size /
o LM&0 AND LM150 . . _— L , B
10DD FILES

2. Extract the downloaded IODD zip file and save it to a desired location.
Repeat this process for every Banner |O-Link device that is connected to the 10-Link master.

3. Open the 10-Link Configuration Software and click File > Load IODD in the upper left corner of the window.

Load IODD

\ 10-Link Configuration Software

@ IO-Link®

BANNERE

e o i AL 1905 10 M D

@ i Connecied [
A File Explorer window opens.
4. Navigate to where the I0DD file was extracted to in File Explorer and click on it.
5. Click Open in File Explorer.
Open the IODD File
19
C= =

@ Hot Connectes

The file explorer window closes, and the I0DD file loads into the 10-Link Configuration Software.

Connect to the Software

Connect a Serial |O-Link Master
1. Click Connect on the |O-Link Configuration Software start page.

June 11, 2024 © Banner Engineering Corp. All rights reserved. page 9
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Connect the Device

Fle Home log  Help
> Load IODD O Exit

10-Link Configuration Software
<«

@ IO-Link®

3
BANNER

RASC RS0 and DXRSD

@ Not Connected

2. In the pop-up window, select Serial, and then click Connect.

Select Serial

Fle Home Log Help

> Load 100D € Exit

10-Link Configuration Software

Comm Port: | COM2.

Baud Rate: | 19200

BANNE“

o ueewith RASC. RSOC and DXVIRSD 10-Unk Ve Davicss

@ Not Connected

The Banner 10-Link master and devices are now connected to the IO-Link Configuration Software. The connected |0-Link
devices appear in new tabs within the software window, and the status in the bottom right corner now reads as Connected.

Serial Connected

File Home log  Help A

? Load I0DD @ Exit

R4SC | LESSOKQP (@) ‘—

[
Vendor Banner Engineering Corporation
10-Link VendorID | 451

Product Info

Product Name R45C
Description 2 Port 10L Master (winw.bannerengineering com/io-link)
Revision 17
Master I 219585
FW Revision 2

10-Link Master: R45C @ Connected

Connect an Ethernet I0-Link Master

1. Click Connect on the |O-Link Configuration Software start page.

page 10 © Banner Engineering Corp. All rights reserved. June 11, 2024



Installation Instructions

10-Link Configuration Software Instruction Manual

File  Home  Log

Connect the Device

Help
> Load 10DD O Exit

10-Link Configuration Software

e

@ IO-Link®
@ Not Connected
2. In the Connect window, select Ethernet, and click Scan.
Select Ethernet

 10ad I0DD € Bxit

10-Link Configuration Software
Y

@ Connectt. o

nfo
Serial @ Ethernet

®
Scan

Scan ‘

1P Addr:

Port®

Cancel Connect

BANNER ]

- s witn ASC. RSOC and DIMASD 0-Link Msar Dvices

@ Not Connected
When the scan is complete, a new pop-up window appears.

3. In the new pop-up window, select the subnet the 10-Link master is connected to from the drop-down menu, and click
Go.

Select Subnet

File  Home

Log  Help
# Load I0ED € Exit

10-Link Configuration Software

@ scan fora Device

o x

10.10.14.°
10.10.15.%
16¢ X
160.2542%
169.254.3.%
192.168.0.*

'3
BANNER

o8 with RASC. RS0C snd DXVIRSO -k MsierDivic

@ Not Connected

The model number and the IP addresses of the connected Ethernet |10-Link masters are displayed
4. Select the IP address of the |O-Link master to connect to, and click Confirm.

June 11, 2024
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Select IP Address and Model Number

Fle Home log  Help &
¥ Load I0DD @ Exit

10-Link Configuration Software

@ scan fora Device = I 9

\ Subnetto Scan: | 192168.0.%  + Go
192.16803 - DXMR110-8K
192.168.0.10 - DXMRI0-4K

e v

o
BANNER

For use with RASC, RSO and DRSO 10-Link Mastar Dvicas

@ ot Connected

The pop-up window closes, and the IP address of the connected 10-Link master auto-fills in the Connect window.
5. Click Connect to connect to the 10-Link master.

Connect Ethernet

Flle Home log  Help ~

 L0ad I0DD @ Bxit

10-Link Configuration Software

@ connectt.. — O X

Serial ® themet
Scan Scan

1P Addr: 19216803
Port® 8241

Cancel

@ Not Connected

The Banner IO-Link master and devices are now connected to the |O-Link Configuration Software. The connected 10-Link
devices appear in new tabs within the software window, and the status in the bottom right corner now reads as Connected.

Fle Home Log Help -
# Load IODD @ Exit
OXMRTI0.8K | LESSOKGP (1) <_
Genenl
Vendor Info
Port Setup
Vendor Banner Enginesring Corporation
10-Link Vendor ID 451
Product Info
Product Name DXMR110-8K
Description 8 Port ICL Master (www.bannerengineering.com)
Revision 0
Master ID 814332
FW Revision 1020

10-Link Master: DXMR110-8K @ Connected

page 12 © Banner Engineering Corp. All rights reserved. June 11, 2024
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Chapter 4 Configuration Instructions

Read and Change the Banner 10-Link Device Configuration

1. Select the device tab in the software window, and click Parameters in the left menu.

Parameters is used to read and change the Banner IO-Link device configuration. After clicking on Parameters, the
Parameters pane opens within the device tab.

Parameters
File  Home  Log  Help -~

F Load 10DD © Exit

RASC | KSOProFF/PB | LESSOKQP

RW val Cmd State Units

USE: R45C Connected

2. Click Read Params to read the current configuration of the connected Banner I0-Link device.

Read Params

File Home log  Help ®

# Load 10DD @ Exit

RASC | KSOProFF/PB | LESSOKQP

Val Cmd State Units

Us8: R45C Connected

This displays the current 10-Link configuration information in the Parameters pane, along with all of the device's
available settings.

3. If desired, make any changes to the Banner IO-Link device's configuration in this pane using the available settings.
4. If changes were made to the settings, write the changes to the device by clicking Write Params.

June 11, 2024 © Banner Engineering Corp. All rights reserved. page 13
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Write Params
File Home Log Help
* Load IODD @ Exit
R45C LESSOKQP

Generic
Read Params

Write Params (—

Process Data
Parameters
Parameters
Command Name RAW val Cmd State Units
» Parameters: Custom Animation Settings

+ Parameters: Custom Color 1 Configuration

» Par:

Custom Color 2 Configuration
» Parameters: Device Access Locks

» Parameters: Executable Commands.

4 Parameters: Operation Mode

Output Settings Off Delay... | w
» Parameters: State 1 Parameters.
» Parameters: State 2 Parameters

» Parameters: State 3 Parameters

UsE: R45C

Process Data

Configuration Instructions

Process data refers to the information that the device reads and transmits to the master, such as the distance reading on a

laser measurement sensor.

Process data can also refer to information that is transmitted to the device from the master, such as messages sent to a

tower light indicating which color segments should be illuminated.

Cyclic and acyclic process data can be transferred between an 10-Link master and an |O-Link device. By clicking Process
Data in the left menu, the user is able to view the live process data of the Banner 10-Link device connected to the 10-Link

master.
Process Data IN is data that is sent from the |O-Link device to the IO-Link master.

Process Data OUT is data that is sent from the 10-Link master to the 10-Link device.

Process Data
File  Home Log Help
'_Load 100D © Exit

R4SC | K30

FF/PE | LESSOKQP

Process Data IN Process Data QUT

Name val Name val
Job Input | 0

Output State | 1

State | Z

Write

USB: R45C

page 14 © Banner Engineering Corp. All rights reserved.
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Process Data Out

Users can interact with Process Data Out through drop-down menus and by writing values in the Process Data OUT panel of
the software. Process Data Out can be written to the 10-Link device by selecting clicking Write after the necessary changes
are made.

Process Data Out

File  Home

2 Load I0DD & Lo:

DXMR90-4K | ROSH

Process Data IN Process Data OUT
val

Write

10-Link Master: DXMR90-4K @ Connected

Read and Change the Banner I0-Link Master Port
Configuration

The |0-Link Configuration Software has a special tab for configuring the port settings on the 10-Link master. To access, click
on the I0-Link master tab and select PortSetup.

File Home log  Help a
? Load I0DD @ Exit
RIOC | KSOProFF/PB  LESSOKQP  SISC-U  S1SC-U
General
PortSetup Param Name Port 1 Port 2 Port3 Port 4.
Port Mode 10L AUTOSTART ~| 1oL AUTOSTART ~| [loL auTosTART = [1oLAuTOSTART
0 o 2| |peacvare .
>l |10t Manal
251 51 10L AUTOSTART 251
bic/a
393220 327681 DO C/Q 659470

Diserets Cn 2 (pin2)
10 Behavier Digtal Input ~| | Dissbled v |Disabled ~| [Disabled
Input Type Normal ~| | Diagnostic Input | | Diagnostic input -] [Normal

Read Write Read Wiite Read Wiite Read Write

Usg: ROOC Connected

The operating mode can be configured for any port on the IO-Link master. The following modes can be used:

Deactivated
Use deactivated mode for any unused 10-link master ports if a device is not connected.
10-Link Manual
The |0-Link master only connects I0-Link devices that have a certain vendor ID and device ID (1: IOL_MANUAL).
10-Link Autostart
The I0-Link master connects to every connected 10-Link device (2: IOL_AUTOSTART).
Digital Input
The 10-Link port functions as a standard digital input (3: DI_C/Q).

June 11, 2024 © Banner Engineering Corp. All rights reserved. page 15
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Digital Output
The 10-Link port functions as a standard digital output (4: DO_C/Q).

When the backup function of the |0-Link master is used, the 10-Link master automatically provides the saved parameters to
the new device after replacement. This makes IO-Link device replacement seamless in 10-Link applications. Another
common industry term for this function is data storage mode.

. Backup+Restore Mode

If a port on the 10-Link master is set to Backup+Restore, then the new device added to the IO-Link port takes in the
same device configuration as the device that was just replaced, as the 10-Link master had stored the last configuration
change by a backup (3: Type compatible Device V1.1, Backup + Restore).

. Restore

If the port on the 10-Link master port is set to Restore, then the new device takes in the configuration according the
settings saved in the master at the time of the last backup. Because possible configuration changes were not saved in
the master, a different behavior from the previous one before the replacement may occur (4: Type compatible Device
V1.1, Restore).

Make changes to the ports' settings by selecting the drop-down menus for each port. To read the current configuration of
each port, select the applicable Read button. After making the desired changes to the port settings, select the applicable
Write button.

Write Port Settings

File  Home Llog  Help
2 Load I0DD O Exit

ROOC | KSOProFF/PB  LESSOKQP  S1C-U  S15C-U

PortSetup Param Name Port 1 Port 2 Port 3 Port 4
Port Mode IOL AUTOSTART - I0L AUTOSTART M 10L Manual - DEACTIVATE
Port Cycle Time. (B 03 [
451 451 251

DavicaID 303220 327681 650465

Digital Input ~| | Disabled ~| [ Digital Input
Normal ~| | Diagnostic Input ~| | Diagnostic Input
Write

Read Wiite Read Read Wiite Read Write

Us8: R9OC Connected

Save and Load |O-Link Master Port Setup and |O-Link Device
Parameters

Users can save and load 10-Link master port setup and 10-Link device parameters.

These configurations can be saved to a PLC for later use, or can be emailed to others in different locations for rapid
configuration of 10-Link masters and IO-Link devices. To save I0-Link master port configurations, 10-Link device
configurations, or both, users can configure the 10-Link master port set up and 10-link devices as required.

Save Port Setup and Parameters

To save a configuration:

1. Ensure that the configurations are written to the 10-Link master and IO-Link devices:

a. Click Write on all of the ports in the port setup tab.
b. Click Write Params on the 10-Link device configurations tabs.

2. Click Save Config.
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Save Config
File Home Device Llog Help
2 102d I0DD fa Load Config B Save Config @ Exit

DXMR90-4K | K50 Pro FF/PB (4)

Process Data | | Read Params | | Wiite Parar

Parameters

Parameters ~ Q
Commond Name o wl Cmd Ste unis
ey
e
4 Parameters: Operation Mode
Operation Mode ™ Demd S
« Parameters: Output Settngs
Output SttingsOutput Sote | Normaly Open
Output Setings O Delay Type. | rw esing Eloe
Output Setings O Dely () | rw o =
P
i Steady
e cow
s Fsh
e
” o
. i
Stoe 1 Porameters O Deey | rw o =
Stote 1 PorametesSaic Sequ. | o
Stote 1 ParametersSequences. | 11
T G -
IO-tink Moster: DXMA904K  Connected
A Save As pop-up window appears.
3. Name and save the configuration file to the PC.
Save As Window
@ seve s x|
4 s ThisPC » Downloads » 234457 (2) v 0] | Search2ssas »
Organize *  New folder
I This PC o Name °
B 3D Objects ] 1e550.config
I Desktop ] Light demo mode.config
= Documents | pert and device settings.config
- [] port settings.config
¥ Downloads .
| Sick.config
b Music ] sick3.cenfig
&= Pictures ] sickconfig2config
B videos ['] T30R 4-20 Negative.config
% Local Disk (C3) [ T30R config.config
v < >
[Ty 50 and 10 link Master configuration. |
Save astype: 10 Link Config Files {*.config) =
~ Hide Folders Save Cancel

After clicking Save, a Save Config pop-up window appears.
4. Select one or more of the following options:
o Save lO-Link Master Port Setup
o Save |O-Link Device Parameters

Save Config Pop-up Window

@ Save Config = O hd

Please select data to save

| Save 10-Link Master Port Setup
[] Save I0-Link Device Parameters

Confirm

5. After selections are made, click Confirm.
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The configuration file is saved, and can now be loaded into other 10-Link masters and devices.

NOTE: The same IO-Link masters and devices that were previously configured and saved must be used.

Load Port Setup and Parameters
To load a saved configuration:

1. Open a new instance of the Banner |O-Link Configuration Software.

2. Read the current |10-Link master and 10-Link device configurations:

a. Click Read on each port in the port setup tab.
b. Click Read Params in each of the |0-Link device tabs.

3. Click Load Config.

Load Config
File Home

DKMRSO-4K

Q
ikt DUMRSAK Comnacted
An Open pop-up window appears.
4. Navigate to where the configuration file is saved on the PC and open the file.
Open File Window
@ Open X
) » ThisPC > Downloads » 234457 (2) v O »
Organize New folder = M @
Attachments A Name i Tre
Documents | ] K30 and 10-Link Master Configuration.co... co
Pictures ] le350.config co
9 This PC "] Light demo mode.config co
N s J port and device se.ttings.config :,
|| port settings.config co
I Desktop ] Sick.config )
5| Documents ] sick3.config co
- Downloads [] sickeonfiga.config co
D Music [ ] T30R 4-20 Negative.config co
& Pictures ] T30R config.config co
B Videos ] test file.config co
[] test.config ca
i Local Disk (C:)
== sfoley (\\hq-fileserverd1\home) (H:)
= Marketing (\\hg-marksting) (M:)
= ProductMgmt_Marketing (\\sx-silex\WirelessRnD)
vl >
File name: [ K50 and 10-Link Master Configuration.config | | config Fites (*.config) v

After clicking Open, a Load Config pop-up window appears.
5. Select one or more of the following options:
o Save IO-Link Master Port Setup
o Save |O-Link Device Parameters
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Load Config Pop-Up Window

@ Load Config = O x

Please select data to load

| Save |0-Link Master Port Setup

| Save 10-Link Device Parameters

Confirm

6. After selections are made, click Confirm.
A Configuration Successfully Loaded pop-up window appears.
7. Click OK to close.

Configuration Successfully Loaded Pop-Up Window

Load Configuration *

.’ 1
':o_' Configuration Successfully Loaded

8. Ensure the newly loaded configuration is written to the 10-Link master and IO-Link devices:

a. Click Write on all of the ports in the port setup tab.
b. Click Write Params on the 10-Link device configurations tabs.

The saved configuration is now successfully loaded onto the 10-Link master and IO-Link devices.

Discrete Channel Visualization and Control

Setting Discrete Ch 1 (pin2), Discrete Ch 2 (pin4), or both to discrete inputs in Port Setup causes an LED status icon to
display on the corresponding Input Status:

» On is signified by a green icon
« Off is signified by a red icon

Click Read to see the current discrete Input Status.
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Discrete Input Status

File Home Device log  Help
2 Load 100D © Exit
DXMR110-8K
Genens!
portsetop | Param Name Port 1 Port2

Port Mose oo +| [oLavosTarr

o CycTime ot 02 0% 0%
Vendor 10 0 o 0 0 o 0
owiee0 0 o o 3 o 0
[re—

)

pTs | Tromsstor -

mtsons @

Ouep Toe

Tisper s

artogs [ 1erted

Sugmese [ Disgrestc

Oscmecn2 sz

Osewier Digiallput  ~| [ Digolinpwt  ~| |Digiallnput -] | Disabled -] [ Diabled - | Dissbied
Tigger g

moutis [ Noma | Nomal < [Nomal | Nomal [ Nomal *] [Noma
s @ —— (]

Clear Al fead Wiite Read Write Read Write Read Wiite Read Write Read

10-Link Master: DXMR110-8K

Port4 Ports Port6

Configuration Instructions

I0LAUTOSTART _»|  [10LAUTOSTART » | [10LAUTOSTART =] [iC

B

[

o

- [o

< [N
Wiite

@ Connected

Setting Discrete Ch 1 (pin2), Discrete Ch 2 (pin4), or both to discrete outputs in the Port Setup allows for the manual
configuration of those discrete outputs. To turn them on, select Trigger Output, and then click Write.

Trigger Output

Fle Home Device log  Help
2 Losd 100D @ it
DIMRTI0-8C | K50 Pro FE/PB (4)

General

PotSewp  ParamName Port 1 Port2 Port3 Port4 Port 5

Port6

For: Mace Do ~| [oLavtosmrr _~| [Dica =] [1oLManual =] [l manval =] [ioLauTosTaRT

PorCycleTime [ [

vinser> 0 o 0 51 0
P ° o 0 w0
Vitznytacp Device 1.1 Backup/Restore ~| | No Devie check ~
Obrescn1 ey
(o Eectomechanical ~
P °

Ouputnpe | PP -

Invened

Disgnostic
[—

sewior |DigilOuput - | Dighallput | Digitallnput __ ~| | Disabled -] pissblea -
Tsswovpn 7] ——

wpatos | Normal +| Nomal *| Nomal +| [ Norma +| [ Nomal -
opit s Y °

Clear Al Resd Write Resd Writs Read Write Resd write Read Write

10-Link Master: DXMR110-8K

0

Disabled

Normal

Resd wiit

Connected

Change the IP Address on the DXMR90-4K and DXMR110-8K

|O-Link Masters

1. Click Device > IP Settings.

Navigating to Device > IP Settings

ﬁla—uam} Device  Log Help

@ IP Settings

CXMR] K

General
Vendor Info
Port Setu

Vendor
10-Link Vendor ID

— Product Info
Product Name
Description
Revision

Master ID
FW Revision
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2. In the pop-up window, select Static IP, DHCP, or Follow DXM XML Settings from the drop-down menu.

3. Enter the desired IP address settings, and click Change IP Settings.

Changing IP Address Settings

@ P Settings — O *

—— Static P -

Mew IP Address: | 19216804
Subnet: |255.255.255.0

Gateway: |0.0.0.0

Change IP Settings ‘—

Change the Server ID on the R90C-4K-MQ and R45C-2K-MQ

|O-Link Masters

Connect the R45C-2K-MQ or R90C-4K-MQ to the PC, and then to the I0-Link Configuration Software (see "Connect the
Cables" on page 6 and "Connect to the Software" on page 9). A pop-up window appears after clicking “Connect.”

1. Select Serial.
2. Click Find.

Identifying the Current Server ID

Fle Home log Help
> Load I0DD @ Exit

10-Link Configuration Software

Comm Port; | COM7

Baud Rate: | 19200

Parity: None

Set

Connect

Cancel

BANNER ]

L5 Wit RASC2KCNCL RS0-4K-MO, DHMRSS-<K anh DXMII103€10-Link Masear Devices

The software displays the current server ID of the connected |O-Link master.
3. Change the server ID of the 10-Link master by using the up and down arrows.
4. Click Set to apply the new server ID to the 10-Link master.

June 11, 2024 © Banner Engineering Corp. All rights reserved.
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Changing the Server ID

10-Link Configuration Software

B Commectt. —
® Seial

Camm Port

@ rot Connacred

A pop-up window displays that the server ID change was implemented successfully. Click OK to close.

Server ID Updated Successfully

File Home Llog Help
? Load 100D © Bxit

10-Link Configuration Software

@ Connec = u]
B
® Serial Ethernet

Update Successful

3
BANNER

For sz ioh RASC.2X-MOQ, RS0-8K-MQ, DXVRSD-4K and DIMARTT0-BK 0-Link Mster Dices.

@ Not Connected
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Accessories

Chapter 5

|O-Link Hardware

Model

BWA-UCT-900

Model
STP-M12D-406
STP-M12D-415

STP-M12D-430

June 11, 2024

4-Pin Threaded M12 RS-485 to USB Adapter Cordset, with Wall Plug

Length

1m (3.28 ft)

Length
1.83 m (6 ft)
4.57 m (15 ft)

9.14 m (30 ft)

Style

Straight

Dimensions

s
@k,

4-pin M12 D-code to RJ45 Shielded Ethemet

Style

Straight

Dimensions

-

RJ45

r 474 Typ.l

M12x1.0 ~

2145~

© Banner Engineering Corp. All rights reserved.

Pinout (Female)

2 4
1 3
1 = Brown
2 = White
3 =Blue
4 = Black

1 = White/Orange
2 = Orange

3 = White/Blue

6 = Blue

2 1

3 4

1 = White/Orange
2 = White/Blue

3 = Orange

4 = Blue
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Chapter 6

Maintenance

Maintenance tasks include updating the 10-Link Configuration Software as new versions become available.

Update

the Software

Product Support and Maintenance

The current version of the 10-Link Configuration Software is available for download from https://www.bannerengineering.com/
us/en/products/part.811445.html.

When connected to a network, if a IO-Link Configuration Software update is available, a red icon a displays in the bottom
right corner of the 10-Link Configuration Software. Click this icon to update the software to the latest version.

|O-Link Configuration Software Release Notes

Version Devices General
293 Added support for drop-down menus in Process Data OUT. The addition of drop-down menus allows for better interaction with
Process Data OUT.
. . . . Users can now save 10-Link master and 10-Link device configurations to
Added support for saving, loading, and sending |0-Link master - ) . :
21.7 port settings and I0-Link device configurations. their PC, and Ioz_ad the_se configurations to new devices. Users can also
send these configurations to others.
210 Added functionality for discrete channel status and control in Users can now visualize discrete inputs and trigger discrete outputs in the
o Port Setup tab. port setup tab.
2.0.37 Added support for setting the server ID on serial 10-Link 10DD Finder API support for automatic searching and downloading of
masters R90-4K-MQ and R45C-2K-MQ. 10DDs.
2.0.29 Added support for DXMR110-8K I0-Link Master, Ethernet DXMR90-4K and DXMR110-8K can connect via Ethernet, and IP
connectivity, and IP addressing functionality. addressing functionality added.
2.0.7 Added support for DXMR90-4K 10-Link Master. Can now connect multiple devices and configure multiple ports.
1.0.16 Supports R45C and R90C 10-Link Master devices. Initial release.

Contact Us

Banner Engineering Corp. headquarters is located at: 9714 Tenth Avenue North | Minneapolis, MN 55441, USA | Phone: + 1
888 3736767

For worldwide locations and local representatives, visit www.bannerengineering.com.

Banner Engineering Corp Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner
Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been
defective during the warranty period. This warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner

product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT
LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF

PERFORMANCE, COURSE OF DEALING OR TRADE USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING
CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY

June 11, 2024 © Banner Engineering Corp. All rights reserved. page 24
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INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE
PRODUCT, WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any
product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for
personal protection applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product
without prior express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document are subject to change;
Banner reserves the right to modify product specifications or update documentation at any time. Specifications and product information in English supersede that
which is provided in any other language. For the most recent version of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.

Banner Engineering Corp. Software Copyright Notice

© Banner Engineering Corp., All Rights Reserved.
https://www.bannerengineering.com/us/en/company/terms-and-conditions.html

Disclaimer of Warranties. This software is provided "AS-IS." To the maximum extent permitted by applicable law, Banner, it affiliates, and its channel partners
disclaim all warranties, expressed or implied, including any warranty that the software is fit for a particular purpose, title, merchantability, data loss, non-
interference with or non-infringement of any intellectual property rights, or the accuracy, reliability, quality or content in or linked to the services. Banner and its
affiliates and channel partners do not warrant that the services are secure, free from bugs, viruses, interruption, errors, theft or destruction. If the exclusions for
implied warranties do not apply to you, any implied warranties are limited to 60 days from the date of first use of this software.

Limitation of Liability and Indemnity. Banner, its affiliates and channel partners are not liable for indirect, special, incidental, punitive or consequential damages,
damages relating to corruption, security, loss or theft of data, viruses, spyware, loss of business, revenue, profits, or investment, or use of software or hardware
that does not meet Banner minimum systems requirements. The above limitations apply even if Banner and its affiliates and channel partners have been advised
of the possibility of such damages. This Agreement sets forth the entire liability of Banner, its affiliates and your exclusive remedy with respect to the software
use.
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